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When users enter address information, you want them to be able to select the state from a
static list of values. You have not used a list of states before, and there is no database
table that contains state information.
 
 
What is the first step in creating such a list of values as quickly as possible?
 
 
A. invoke the LOV wizard. 
B. Create a new record group that is based on a SQL query. 
C. Create a new static record group. 
D. Create a list item instead; a list of values is not appropriate for a static list. 
 

Answer: A

Explanation: ow to create LOV in Oracle forms? 

List of Values(LOV) are used either when a selected list is too long and hence would not be

appropriate for a drop down, but needs a search form to select the value. 

Steps to create LOV functionality: 

* Click on the LOV icon in the object navigator and choose a manual/automatic wizard. This

will create a record group. 

* Open a search form in the Dialog Page 

* Select values inside this form. 

* Return selected values to the original page. 

 

 

 

 

 

You have created an editor named MyEditor, and you want it to be available to edit the text
item Product_Description. You can associate the editor with the text item by setting the
Editor property of Product_Description to MyEditor.
 
 
A. True 
B. False 
 

Answer: A

 

 

Question No : 1
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There are certain errors that are specific to the Salary item on the Employees form. You
want to trap these errors only when the user navigates from the Salary item.
 
 
You have a form-level On-Error trigger that traps errors that apply to the form in general,
but yon additionally code an item-level On-Error trigger for the Salary item.
 
 
When testing the form, you find that the general errors are not trapped when you navigate
from the Salary item. What can you do to correct this problem?
 
 
A. Call the form level On-Error trigger from the item-level On-Error trigger. 
B. Call the item-level On-Error trigger from the form-level On-Error trigger. 
C. Change the Execution Hierarchy property for the item-level On-Error trigger. 
D. Change the Execution Hierarchy property for the form-level On-Error trigger. 
E. Move all the code to a PL/SQL program unit and call it from both the form level and item
level On-Error triggers. 
 

Answer: C

Explanation: when you have a WHEN-NEW-ITEM-INSTANCE :if you create a trigger on

item, block and form-level, then only the ITEM-Level will start. If you use the exec-hierarchy

Override.If all trigger use After, then the FORM, BLOCK and ITEM starts in that

sequence.If all trigger use Before, then the ITEM, BLOCK and FORM starts in that

sequence.the execution-hierarchy on FORM-Level is ignored, because there is no higher

level than FORM 

 

 

 

 

You have a form that called a database stored procedure. You do not want processing to
continue, so immediately after the call to the stored procedure, you add the following code:
 
 
IF NOT FORM_SUCCESS THEN
 
MESSAGE ('Stored Procedure failure');
 
RAISE FORM_TRIGGER_FAILURE;
 
END IF;
 

Question No : 3
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You test the code and input some data that intentionally causes the stored procedure to
fail. However, the message that you defined does not appear. What are two possible
reasons for this?
 
 
A. You must handle database errors in an exception clause of the trigger. 
B. You must test for FORM_FAILURE when testing for failure of a stored procedure. 
C. You must test for FORM_FATAL when testing for failure of a stored procedure. 
D. FORM_SUCCESS tests for failure of Forms built-ins, not stored procedures. 
E. You cannot test for failure of a stored procedure, because database errors are
transparent to Forms. 
 

Answer: A,D

Explanation: A: You should use DBMS_ERROR_CODE and DBMS_ERROR_TEXT in an

ON-ERROR trigger to trap errors propagated from Oracle server from Forms. 

 

 

Note: FORM_SUCCESS and FORM_TRIGGER_FAILURE 

 

Either the FORM_SUCCESS built-in or the FORM_TRIGGER_FAILURE exception must

be used to handle all Forms errors. FORM_SUCCESS is a Boolean function that evaluates

to TRUE or FALSE depending on the success or failure of a Forms built-in.

FORM_TRIGGER_FAILURE is an exception that has to be raised to stop further

processingwhenever an error occurs or FORM_SUCCESS evaluates to FALSE. The

following sections describe their use in error-message handling. 

 

 

 

 

Identify a function of the Forms Servlet.
 
 
A. It creates a dynamic HTML file. 
B. It starts a Forms runtime session. 
C. It manages network requests from the Forms Client. 
D. It connects to and communicates with the database server. 
E. It renders the Forms Services application display for the user. 
 

Answer: A
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A user at a remote location reports a problem that occurs when the Orders; form runs and
the user clicks the invoice button. You are not able to reproduce the problem, so you
decide to use remote debugging.
 
 
The steps involved in diagnosing the problem are listed below, but they are ordered
incorrectly. What is the correct sequence of Steps?
 
 
1. You set a breakpoint in the When Button-Pressed trigger for the invoice button.
 
2. The user's screen goes blank.
 
3. The user reports the host and port to you.
 
4. You uses the debugger to step through the code.
 
5. The user clicks a button that calls DEBUG.ATTACH.
 
6. You attach to the user's process.
 
7. You open the Orders.fmb file from which the running .fmx was generated.
 
8. The user clicks the invoice button.
 
 
A. 5, 3, 6, 7, 1, 8, 2, 4 
B. 8, 3, 6, 5, 4, 7, 1, 2 
C. 7, 1, 3, 6, 5, 1, 8, 4 
D. 3, 6, 5, 7, 8, 1, 2, 4 
 

Answer: A

 

 

You have written a When-Validate-Item trigger. You want this trigger to fire even if the form
is in Enter-Query mode. What must you do to achieve this?
 
 
A. Use the following code at the start of the When Validate-Item trigger: 
:SYSTEM.mode := 'ENTER-QUERY'; 
B. Use the following code at the start of the When Validate Item trigger: 
:SYSTEM.mode := 'NORMAL'; 
C. Set the Fire in Enter Query Mode property of the When-Validate-Item trigger. 
D. You do not need to do anything, because the default for the When Validate Item trigger

Question No : 6
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is to fire in Enter-Query mode. 
E. You cannot achieve this, because the When-Validate-Item trigger cannot be set to fire in
Enter-Query mode. 
 

Answer: E

Explanation: Coding Triggers for Enter-Query Mode 

Some triggers that fire when the form is in Normal mode (during data entry and saving)

may also be fired in Enter-Query mode. You need to consider the trigger type and actions

in these cases. 

“Fire in Enter-Query Mode”Property 

To create a trigger that fires in Enter-Query mode, in its Property Palette set the “Fire in

Enter-Query Mode”property to Yes. This property determines whether Forms fires a trigger

if the associated event occurs in Enter-Query mode. Not all triggers can do this. See last

line in note below. 

 

By default, the “Fire in Enter-Query Mode”property is set to Yes for triggers that accept this.

Set it to No in the Property Palette if you want the trigger to fire only in Normal mode. 

 

Note: 

The following triggers may fire in Enter-Query mode: 

*Key- 

* On-Error 

* On-Message 

* When-triggers, 

except: 

-When-Database-Record 

-When-Image-Activated 

-When-New-Block-Instance 

-When-New-Form-Instance 

-When-Create-Record 

-When-Remove-Record 

-When-Validate-Record 

-When-Validate-Item 

 

 

 

You wish to use a javaBean in a form. This javaBean has no visible component.
 
 

Question No : 8
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You use the Layout Editor to create a bean area item that implements this JavaBean. You
want to be able to see the bean area item in the Layout Editor so that you can easily
interact with it at design time.
 
 
What can you do to ensure that the bean area item does not appear on the form at run
time?
 
 
A. Set its Visible property to No. 
B. Set its Height and Width properties to 1. 
C. Set its Implementation class programmatically at run time. 
D. You do not have to do anything; if Implementation Class does not display a visible
component, the bean area does not show at run time. 
E. You cannot avoid displaying the Bean area at run time. 
 

Answer: A

 

 

You are planning the alerts that are needed for your Human Resources application. You
wish to display the following in alerts:
 
* A message to inform the user about being at the just record
 
* A warning about a potential conflict with the data just entered
 
* A message to display a validation error to the user
 
* A warning that the salary is out of range and that asks whether the user wants to correct it
 
 
You want the note symbol (

) to appear on alerts that display only informative messages, the warning symbol to appear
on messages where you will allow the user to continue despite some data problem, and the
alarm boll symbol to appear where the user will not be allowed to continue without
correcting the situation that caused the alert to be displayed.
 
 
You want to define the minimum number of alerts possible and customize them at run time.
 
 
Which alerts should you define?
 
 
A. One Note style alert and caution style alert 
B. One Note style alert and one Stop style alert 

Question No : 9
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C. On Caution style alert and one stop style alert 
D. On Note style alert, one Caution style alert, and one Stop style alert 
E. Two Caution style alerts and one Stop style alert 
 

Answer: D

Explanation: In this scenario we need three different kind of alerts. 

 

How to Create an Alert 

Like other objects you create at design-time, alerts are created from the Object Navigator. 

1. Select the Alerts node in the Navigator, and then select Create. 

2. Define the properties of the alert in the Property Palette. 

Here are the properties that are specific to an alert. This is an abridged list. 

 

http://www.erplearner.com/Sources/Form%20Builder_files/image346.jpg 

 

Note: Alerts are an alternative method for communicating with the operator. Because they

display in a modal window, alerts provide an effective way of drawing attention and forcing

the operator to answer the message before processing can continue. 

 

Note 2: Potentially, you can create an alert for every separate alert message that you need

to display, but this is usually unnecessary. 

You can define a message for an alert at run time, before it is displayed to the operator. 

This means that a single alert can be used for displaying many messages, providing that

the available buttons are suitable for responding to each of these messages. 

Create an alert for each combination of: 

* Alert style required 

* Set of available buttons (and labels) for operator response 

For example, an application might require one Note-style alert with a single button (OK) for

acknowledgment, one Caution alert with a similar button, and two Stop alerts that each

provide a different combination of buttons for a reply. You can then assign a message to

the appropriate alert before its display, through the SET_ ALERT_PROPERTY built-in

procedure. 
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Reference: Oracle Forms Student Guide, How to Create an Alert
 
 

 

 

The Orders form is sometimes run automatically and sometimes run from the Customers
form, when it is run from the Customers form, any queries should be restricted to the
customer that is currently selected. The Customers form button that runs the Orders form
sets a global variable to the current customer ID.
 
 
The Orders form has a button labeled Execute Query with the following When-Button
Pressed trigger:
 
 
DEFAULT_VALUE (NULL, 'GLOBAL.Customer_id');
 
IF: GLOBAL.customer_id IS NOT NULL
 
THEN
 
SET_BLOCK_PROPERTY ('orders', DEFAULT_WHERE, 'orders.customer_id =
 
' | | :GLOBAL.CUSTOMER_id);
 
END IF;
 
EXECUTE_QUERY
 
 
You want to duplicate that functionality in a menu item for the Summit menu that is
attached To the Orders form.
 
 
What changes must you make to the code so that the menu code functions as it does in the
form?
 
 
A. Change both occurrence of :GLOBAL.customer_id to 'GLOBAL.customer_id'. 
B. Change 'GLOBAL.customer_id' in line 1 to :GLOBAL.customer_id. 
C. Change both occurrence of :GLOBAL.customer_id to NAME_IN
('GLOBAL.customer_id'). 
D. You do not need to change anything; the code compiles and functions correctly in the
menu item. 
E. You cannot add this type of code in the menu because it refers to the items on the form

Question No : 10
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that cannot be referenced from a menu. 
 

Answer: D

 

 

The Orders form has four blocks. The Orders and Order_items block are on the CV_Order
content canvas; the inventories block items are on the CV_inventories content canvas; and
Control block buttons are on the CV_Buttons toolbar canvas. All buttons have mouse
Navigate set to No.
 
 
The Order_Items block is a detail of Orders. The inventories block is a detail of
Order_Items, showing the stock of the selected product.
 
 
There is a button in the Control block with a When-Button-Pressed trigger:
 
 
IF GET_CANVAS_PROPERTY(:SYSTEM.cursor_item, item_canvas) = 'CV_ORDER'
THEN
 
GO_BLOCK ('inventories')
 
ELSE
 
GO_BLOCK('orders');
 
END IF;
 
 
When you run the form and click the button, navigation does not occur, and the form
displays the runtime error “FRM-41053: Cannot find Canvas: invalid ID.” What should you
do to correct this problem?
 
 
A. Change the sequence of blocks in the Object Navigator 
B. Chang the Mouse Navigator property of the button to yes 
C. in the first line of code, change the built-in to GET_ITEM_PROPERTY 
D. in the first line of code, change the system variable to: SYSTEM.CURSOR_CANVAS. 
E. in the first line of code, change the CV_ORDER to lowercase 
F. Chang the argument to the GO_BLOCK built-ins to uppercase 
 

Answer: C
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You create a Customers form by using wizards. When you test the form, you notice that
you cannot the complete name that is displayed in the Customer_Name text item. Which
three tools can you use to correct this problem?
 
 
A. Layout Editor 
B. Property Palette 
C. Data Block wizard 
D. Layout wizard 
E. Object Navigator 
F. Object Library 
 

Answer: A,B,D

 

 

Which type of variable must be declared before it is used in a trigger?
 
 
A. PL/SQL variable 
B. Form item 
C. global variable 
D. system variable 
E. parameter 
 

Answer: A

Explanation: PL/SQL is the language used in Forms triggers and program units. 

 

PL/SQL lets you declare variables and constants, then use them in SQL and procedural

statements anywhere an expression can be used. You must declare a constant or variable

before referencing it in any other statements. 

 

Variables can have any SQL datatype, such asCHAR,DATE, orNUMBER, or a PL/SQL-

only datatype, such asBOOLEANorPLS_INTEGER. 

 

Note: 

 

PL/SQL's data types correspond with SQL's column types, making it easy to interchange

PL/SQL variables with data inside a table. 

 

Question No : 12
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View the Exhibit.
 
 

 
 
To test how the Orders application works with database triggers, you add to the Orders
table the following database trigger that fires before the update of Customer_Id:
 
 
BEGIN
 
If :old.customer_id != : new.customer_id then
 
RAISE_APPLICATION_ERROR (-20101, 'Database trigger says no!');
 
end if;
 
END;
 
 
You run the Orders form, change the customer ID, and click Save. You receive the error
message "FRM-40509: Oracle error: unable to UPDATE record." You select Help > Display

Question No : 14
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Error, and the Database Error dialog box that is shown in the Exhibit appears.
 
 
Which code would you put in your Form-level On-Error trigger to display the ORA- error
message instead of the FRM- error message?
 
 
A. IF ERROR_CODE = 40509 THEN 
MESSSAGE (DBMS_ERROR_TEXT); 
END IF 
B. IF ERROR_CODE = 40509 THEN 
MESSSAGE (SQLERRM); 
END IF; 
C. IF ERROR_CODE = 06512 THEN 
MESSSAGE(DBMS_ERROR_TEXT); 
END IF; 
D. IF ERROR_CODE = 06512 THEN 
MESSSAGE (SQLERRM); 
END IF; 
E. IF ERROR-CODE = 20101 THEN 
MESSSAGE (DBMS_ERROR_TEXT); 
END IF; 
F. IF ERROR_CODE = 20101 THEN 
MESSSAGE(SQLERRM); 
END IF; 
 

Answer: A

 

 

View the Exhibit.
 
 

Question No : 15
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The orders form contains two canvases. Orders_CV displays one order and all of its order
items.
 
Help-CV displays context-sensitive help.
 
 
When users invoke the help screen for the Customer_Id item, the help information
obscures the Custormer_Id item, as shown in the Exhibit. Users would like to be able to
see both the item and its help information simultaneously.
 
 
How can you move the help information to the right so that the Customer_Id item is visible?
 
 
A. increase the Viewport X Position on the Help_CV canvas. 
B. increase the Viewport X Position on Canvas on the Orders_CV canvas. 
C. Decrease the Width on the Help_CV canvas. 
D. in the Layout Editor for the Orders_CV canvas, select View > Stacked Views, and then
select the Help_CV canvas. Drag the Help_CV canvas to the right of the Customer_Id item. 
 

Answer: A

Explanation:  

Note: Viewport X Position on Canvas, Viewport Y Position on Canvas property 

Description 

Specifies the location of the view's upper left corner relative to the upper left corner of the

canvas. The size and location of the viewport define the view 

; that is, the part of the canvas that is actually visible in the window to which the canvas is

assigned. 
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Applies to canvas 

 

 

 

 

The Orders form has the following triggers defined:
 
1. Post-Text-Item on Customer_Id
 
2. Pre-Text-Item on Sales_Rep_Id
 
3. When-New-Item-instance on Sales_Rep_Id
 
 
The form's Validation Unit property is set to Record.
 
 
When the user navigates from Customer_Id to Sales_Rep_Id, which triggers fire and what
is the sequence?
 
 
A. 1, 2, and 3 
B. 1, 3, and 2 
C. 1 and 2 only 
D. 2 and 3 only 
E. 3 only 
 

Answer: E

 

 

View the Exhibit.
 
 

Question No : 16
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The Departments form has form level triggers defined as shown in the Exhibit. You have
enabled array DML for the Departments block by setting its DML array size to 5 and setting
the Primary Key property of Department id to Yes. You set runtime preferences for Forms
Builder to use array processing.
 
 
You want to test that array processing is actually occurring, so, as shown in the Exhibit, the
On-Update, On-Delete, and on insert triggers have code that:
 
 
1. Displays a message to indicate which trigger is firing for which record?
 
2. Does the thing (either updates, deletes, or inserts)
 
 
The other triggers simply display a message, indicating the trigger that is firing.
 
 
You run the form from Forms Builder, but from the messages, you can tell that array
processing is not occurring. What should you change so that array DML gets implemented?
 
 
A. Delete the "On-" triggers; these triggers remove default processing, including array
processing. 
B. Set the DML array size to a value of 10 or greater; for array sizes loss than 10, array
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processing Is inefficient, and so is not performed. 
C. Use the SYNCHRONIZE built-in after the MESSAGE built-in; otherwise, the message
are not displayed until the processing is finished, giving the appearance that array
processing is not taking place. 
D. Set the Enforce Primary Key property of the Department block to Yes; it is not enough to
just set the Department_Id to be the primary key. 
 

Answer: D

 

 

View the Exhibit.
 

 
 
You have defined the window, canvas, and text items shown in the Exhibit. What happens
when click Run Form?
 
 
A. The form runs with the cursor initially in TEXT_ITEM8. 
B. The form runs with the cursor initially in TEXT_ITEM9. 
C. The form does not compile until you move TEXT_ITEM8. 
D. The form does not compile until you move TEXT_ITEM10. 
 

Answer: D

 

 

Which setting of :SYSTEM.MESSAGE_LEVEL suppresses all system messages?

Question No : 18
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A. 0 
B. 10 
C. 25 
D. 50 
E. You cannot use :SYSTEM.MESSAGE_LEVEL to suppress all system messages 
 

Answer: E

Explanation: Controlling System Messages 

You can prevent system messages from being issued, based on their severity level.

FormsBuilder classifies every message with a severity level that indicates how critical or

trivial the information is; the higher the numbers, the more critical the message. There are

six levels that you can affect. 

 

 

 

Note: Suppressing Messages According to Their Severity 

In a trigger, you can specify that only messages above a specified severity level are to be

issuedby the form. You do this by assigning a value to the 

MESSAGE_LEVEL 

system variable. Formsthen issues only those messages that are above the severity level

defined in this variable.The default value for 

MESSAGE_LEVEL 

(at form startup) is 0. This means that messages of all severities are displayed. 

 

 

 

You have installed WebLogic and Forms with a default configuration, which has been
tested and determined to be correct.
 
 
After creating a basic form in the Forms Builder, you click Run Form to test it. Forms
Builder displays an error dialog box with the following message:

Question No : 20
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FRM-10142: The HTTP Listener is not running on <host> at port 9001.
 
Please start the listener or check your runtime preferences.
 
 
What is one action that you can take to resolve this error?
 
 
A. Start the Web Logic Administration server. 
B. Start the WLS_FORMS managed server. 
C. Change the serverURL parameter in formsweb.cfg 
D. Start the Oracle HTTP server. 
E. Start WebCache. 
 

Answer: B

Explanation: The WLS managed server WLS_FORMS must be started. 

 

 

 

 

What happens when you click Run Form Debug in Forms Builder?
 
 
A. The form runs on your local machine by using a debug executable client. 
B. The form runs in a three-tier environment by using the application server URL that you
specify in runtime preferences. 
C. The form runs in a three tier environment by using the [debug] configuration in the
FORMSWEB.CFG file. 
D. The form runs in a simulated three-tier environment by using an applet viewer that is
included with the product to enable debugging. 
 

Answer: B

Explanation: Directly from the class materials from Oracle: As in the case when you run a

form from Forms Builder with the Run Form button, the Run Form Debug button runs the

form in a three-tier environment. It takes its settings from the Preferences window that you

access by selecting Edit > Preferences from the main menu and clicking the Runtime tab. 
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In Forms Builder, the iconic buttons on the form are blank, but when you click Run Form
the form appears in the browser with Images in the iconic buttons.
 
 
What are two things that you can check to track the source of this problem?
 
 
A. forms Builder runtime preferences 
B. the UI_ICON setting in the operating system 
C. the iconpath setting in the Forms registry file 
D. the UI_ICOM_EXTENSION setting in the operating system 
E. the iconextension setting in the Forms registry file 
F. the FORMS_PATH setting in the Forms environment file 
G. the classpath setting in the operating system 
 

Answer: B,D

 

 

The Employees database table contains more columns than can be displayed at one time
in a form. You create a data block that uses all the columns. How can you enable users to
interact with all the items and switch between them without scrolling or closing anything?
 
 
A. Define multiple content canvases and display them in multiple modeless windows. 
B. Define multiple content canvases and display them in the same modeless window. 
C. Define multiple content canvases and display them in multiple modal windows. 
D. Define multiple content canvases; display one in a modeless window and the others in
modal windows. 
E. This is not possible because items from a single block must be displayed on the same
canvas and window. 
 

Answer: A

 

 

Which statement is true about flexible code?
 
 
A. It is designed for reuse. 
B. It typically includes hard-coded object names. 
C. It is more difficult to maintain. 
D. It is more difficult to write, so it decreases developer productivity. 

Question No : 23
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E. It is specific to a particular module. 
 

Answer: A

 

 

You have written a Forms application that your users log in to with their database login.
 
Which Forms component is utilized first when a user runs the application?
 
 
A. Forms Client (applet) 
B. Forms Runtime 
C. Forms Servlet 
D. Forms Listener Servlet 
 

Answer: C

 

 

You want to use WebUtil functionality in the Orders form. What three things must you do to
integrate WebUtil into the Orders Form?
 
 
A. Copy the WebUtil object group from the WebUtil object library into a separate object
library. 
B. Subclass the WebUtil object group from the WebUtil object library into the Orders form. 
C. Ensure that the WebUtil block is the last block under the Data Blocks node in the Object
Navigator. 
D. Ensure that the WebUtil block is the first block under the Data Blocks node in the Object
Navigator. 
E. Attach the WebUtil library to the Orders form. 
F. Copy the WebUtil library to the same directory as the Orders form. 
G. in the When-New-Form-instance trigger, register the WebUtil javaBeans. 
H. Set the Implementation Class Property for any items that will implement WebUtil
JavaBeans. 
 

Answer: B,C,E

Explanation: Integrating WebUtil into a Form 

Step 1: Attaching the WebUtil Library (E) 

To use the functions of WebUtil in a Forms application, you mustfirst attach the 

webutil.pll library to any module that will use the WebUtil PL/SQL API. Select theAttached

Question No : 25
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Libraries node in the Orders form and click Create. This invokes the Attach Librarydialog

box, in which you can browse to the location of webutil.pll 

 

 

Step 2: Subclassing WebUtil Forms Objects (B) 

Part of the WebUtil utility is a set of Forms objects contained in webutil.olb 

This object library contains an object group called WebUtil, which you can subclass into

your form. 

 

C: A data block named WEBUTIL; ensure that this is the last block in the Navigator. 

 
Reference: Oracle Fusion Middleware 11g, Build Applications with Oracle Forms,
Integrating WebUtil into a Form
 
 

 

 

You want to display fields of a form module on multiple layouts that are visible
simultaneously, what can enable you to achieve this?
 
 
A. multiple content canvases that display in the same window 
B. one content canvas that displays in multiple windows 
C. multiple content canvases that display in multiple windows 
D. multiple forms, because you cannot have multiple content canvases in the same form
that are visible simultaneously 
 

Answer: C

 

 

You are coding a When-Checkbox-Changed trigger.
 
 
Which statements are available for use in your code?
 
 
A. unrestricted built-ins only 
B. restricted and unrestricted built-ins only 
C. PL/SQL statements and unrestricted built-ins only 

Question No : 27
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D. PL/SQL statement-, and any built-ins 
 

Answer: D

Explanation: When-Checkbox-Changed trigger 

Description 

Fires when an operator changes the state of a check box, either by clicking with the mouse,

or using thekeyboard. 

Definition Level: form, block, or item 

Legal Commands: 

SELECT statements, unrestricted built-ins, restricted built-ins 

 
Reference: Oracle Forms Developer, When-Checkbox-Changed trigger
 
 
 
 

 

 

Users do not want to see the "Working" message while a long query completes.
 
 
You are designing a form with a query that takes o long time to execute. What can you do
to stop the "Working" message from appearing?
 
 
A. Before the line of code that executes the query, add the line: 
:SYSTEM.MESSAGE_LEVEL := '10'; 
B. Before the line of code that executes the query, add the line: 
:SYSTEM.SUPPRESS_WORKING : = 'TRUE'; 
C. Use the SET_APPLICATION_PROPERTY built-in to set the message level in a When-
New-Form-instance trigger. 
D. You do not need to do anything, the default behavior of Forms is to display the
"Working" message only if you add code to do so. 
 

Answer: B

Explanation: You can turn the 'Working...' message off with system.suppress_working

command. 

 

SYSTEM.SUPPRESS_WORKING examples 

Assume that you want to have the form filled with data when the operator enters the form.

The following 

When-New-Form-Instance trigger will prevent the unwanted updates that would normally

Question No : 29
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occur when 

you fill the blocks with data. 

System.Suppress_Working := 'TRUE'; 

Go_Block ('DEPT'); 

Execute_Query; 

Go_Block ('EMP'); 

Execute_Query; 

Go_Block ('DEPT'); 

System.Suppress_Working := 'FALSE'; 

 

 

 

 

 

If a display item has a Calculation Mode of Formula, you can call a program unit to perform
the calculation.
 
 
A. True 
B. False 
 

Answer: A

 

 

View the Exhibit.
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